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Hardware 

The SMART Board interactive whiteboard is touch-sensitive, and uses 

“resistive technology”. It operates as part of a system that includes a 

computer and a projector.  

 

SMART also sells devices called AirLiner Wireless Slate. These are 

wireless and can be passed around the room for students to write on. 

The writing appears on the front screen. 

 

Other products include:  Sympodium Interactive Pen Display, SMART Document Camera, SMART Response 

(formerly Senteo),  SMART Sync 2009 (formerly SynchronEyes),  SMART Table.  

Touching the Board 

Your finger is your mouse. You can control applications on your computer from the interactive whiteboard. 

A press from your finger is the same as a click from your mouse. Either press or double-press with your 

finger as you would click or double-click with your mouse. 

Use consistent and steady pressure. The board can only recognize one point of contact, so try not to touch 

the board with your wrist or arm while writing with your finger. 

Be careful not to trip over the feet of a movable board. If students are too short to reach, don’t have them 

stand on a chair. If they can’t reach, then lower the board. 

To clean the board, you can use a damp cloth with a cleaner such as Windex or Expo spray (use a kind 

without ammonia). 

Pen Tray 

The pen tray consists of four color-coded slots for the pens and one for the eraser. Each slot has an optical 

sensor to identify which pen has been picked up. You can write with the pen or your finger or another 

object as long as a pen is picked up. Pick up the eraser tool to erase on the board. If a pen is lost, you can 

cover the sensor with tape or a post-it note.  
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ON-Screen Keyboard 

1. You can use the keyboard to complete online forms or to enter text in any application.  
2. To open the keyboard, press the keyboard button on the tray of the SMART board.  
3. The on-screen keyboard will appear. There are several views: 

a. Classic (standard keyboard) 
b. Write (good for students who aren’t proficient with a keyboard.) 
c. Simple (fewer keys) 
d. Simple Capitals 
e. Number Pad  
f. Shortcut view.    

 

 
 

             

 

     

Preview pane. Open 

this to see what you’re 

typing, then press send. 

Keyboard settings: 
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Right mouse button 

1. Press the right mouse button on the pen tray.   

2. Your next press on the screen will be recognized as a right-click.  

3. A graphic in the bottom on the screen will appear to remind you that your next press will be 

registered as a right-click. 

4. Tip: instead of pressing the right mouse button, press and hold on the area of the screen where you 
would like to make a right-click. After a few seconds of pressing and holding the area, the right-click 
menu will appear. 
 

Orienting the SMART Board 

Orientation ensures your touch is registered accurately 

when you are using the interactive whiteboard. If you are 

touching an icon and your cursor appears somewhere other 

than where you are pressing, try reorienting the board.  

To do this, press and hold both the 

keyboard and the right mouse 

button on the pen tray until the 

orientation screen appears.   

 

Ready Light 

 

Color of Ready Light Status 

Not lit The board doesn’t have power, check the USB cable connections. 

Solid green The board is successfully communicating with the software on the computer. 

Flashing green The SMART board driver isn’t installed, or isn’t running. Verify that the driver is 

installed, at school ask a tech person to do this. If it continues to flash, contact 

the sales support representative. 

Solid Red The whiteboard has power, but isn’t communicating with the computer.  A brief 

flash of red during power up is normal. 

Flashing amber Occurs only when you are updating using SMART Firmware Wizard, and is normal 

Solid amber Problem state. Try resetting the whiteboard by disconnecting and then 

reconnecting the USB cable at the whiteboard end. 
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Using SMART Notebook software   

In the school district, start the program with the icon located on the Novell Launcher screen.  

From home, open the program either from the Start Menu or a desktop shortcut.  

When you launch the SMART Board Notebook software a Welcome 

Screen will appear. Notice the four tabs at the top of the window. 

You can choose to hide this window with a check in the lower left 

corner. 

 

 

 

When you click New Notebook File, a new blank file will open. Each new file contains a work area that can 

be filled with objects. You can add handwritten notes, typed text, graphics, clip art and Flash files to a file. 

You can add as many pages as you need to capture or display information.  

     side tabs on left 

    same file, side tabs on right 

 

Menu bar 

 
Notice the drop-down menus, from which you can perform many commands. Take a moment to look at the 

menus.  
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Toolbar 

 

 

  

**Note: To customize the toolbar, right click in between any two tools. 
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Measurement Tools    

 

The ruler icon places an interactive ruler onto the page. You can 

make it bigger and smaller just like any other object. Grab it in just 

the right spot and you can rotate it around. A number in the corner 

shows the angle of rotation. If you use the pen very close to the edge 

of the ruler, it will let you draw a perfectly straight line. 

 

 

The protractor tool. Use the pen near the edge to draw a perfect arc. You can toggle between 180 and 360 

degree versions by clicking the blue circle near the base of 

the protractor. Dragging the green circle (and the grey circle) 

will let you move two lines. When you click the green arrow 

it will inject those lines onto the page, with the angle 

between them clearly marked. 

 

 

 

The compass tool. Click and drag at the top of the pencil to move it in and out. Drag the green 

circle to move the compass around without drawing – and click on the point of the pencil to 

draw the circle. 

 

The Geodreieck Protractor 
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SMART Floating Tools 

 

 

Turn on the floating toolbar in one of two ways: 

A. In the district, you probably have an icon on your launcher. Click on it. 

B. At home, click on the Start button, then on Programs, then on Smart Board Drivers, then on Smart 

Tools.  

 

Add an icon to the floating toolbar: 

1. Click on the Gear button at the bottom of the toolbar.   

2. You will see the Customize window appear, as above. 

3. Locate an icon you would like, and drag it from the Customize window onto the floating toolbar.  
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 Digital Ink Layer 

(The Floating Tools must be turned on first.)  

With the Digital Ink Layer, you can make notes or drawings on the screen with one of the pen tools. Use 

with internet pages, PDF files, and other on-screen items.  

                                  

 

 

 

When you remove a pen tool from the tray, a border appears around your desktop. The border indicates 

the Digital Ink Layer is active and the image on the screen is frozen for you to write on it. The Digital Ink 

Layer and its border will remain in place until all pen tools are put away and you touch the board.  

Note: If the Floating Toolbar does not appear, go to the Start Button> Programs> Smart Board folder 

If you accidentally clear your ink, you can restore the notes and drawings by pressing the Click here to 

restore ink icon, which appears in the lower right of the screen. Then use the Capture writing button to 

save your notes.  

If you accidentally clear the writing and do not press the restore ink thumbnail before it disappears, then 

click on the Undo button on the floating toolbar. 

        

 

If you do not see the Click here to restore ink message or don’t reach it before it 

disappears, press the Undo button in the Floating Tools toolbar to restore your 

notes and drawings.  
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Transparent Background Tool 

This is a new tool for version 10.6. In previous versions, when you were writing in Digital Ink, an active 

website would be frozen while you were writing, and you would have to specifically save or close the 

writing before the website would be active again.  

Transparent Background lets you use some SMART Notebook tools with other programs.  It is somewhat 

like using the Floating Toolbar, but you are still in SMART Notebook.  For example,  when using the camera 

capture tool to capture an image.  The image is pasted onto the screen where you would expect it to be 

when using Notebook’s Edit/Paste command.  At this point, you know you are still in SMART Notebook, and 

that “it’s just invisible.”  So, why not just use the Floating Toolbar? Because the new Measurement Tools 

aren’t available from the Floating Toolbar. 

 

This floating toolbar will appear on top of your website/program. 

  or  

 

Try it: 

1. Open a web browser to any website. 

2. Go to Smart Notebook software. Click on the Transparent Background Tool. 

3. Notice the toolbar that appears next to the webpage. 

4. You can now use any tools from this toolbar on top of the webpage. Notice that the webpage is still 

fully active. 

5. For example, open Google Maps or MapQuest, and find a location. Use the Ruler to measure the 

distance between two places, or use the Compass to draw a circle around a place. 

 

 

Clear Screen Tool 

This new tool lets you delete everything on a Notebook page with one touch.  In the past, the only way to 

do this was to Select All and then Delete.  If it’s not showing, you may have to add it to your toolbar. 
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Screen Capture Camera 

The Screen Capture toolbar allows you to capture an image, such as a photo 

from the Internet, to a SMART Notebook page. Click on the Screen Capture 

icon .  Notice the small toolbar that appears with four choices. 

 

**Note: By default, each screen capture you take appears on a new page in your file. If you want to save 
the screen capture to the current page, clear the Capture to new page check box. 

 

Capture a Specific Area of the screen: 

1. Press the Area Capture button on the Floating Tools toolbar.  

 

2. The Area Capture tool will appear, it looks like a plus sign.  Press on any corner of the area you wish 

to capture and, continuing to press, drag the selection box until it surrounds the entire area. 

Example- capturing the Back button on a webpage:  

 

3. Release your press and the selection will be captured as a graphic into the Notebook software. 

Notice that SMART Notebook opens and your image is on a new page. 
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Side tabs 

 

 

 

Page Sorter tab 

Shows a thumbnail of each pages in the current Notebook file. Navigate to the page you want, reorder the 

pages, or add more pages. A border around a thumbnail indicates the active page. Click the dropdown 

menu for choices related to that page.  

 

Note: To move an object from one page to another, simply drag it to the new page. 

  

Page Sorter tab 

Gallery tab 

Attachments tab 

Properties tab 

Move the side tabs to the opposite side of the screen 

Click the arrow on the active page for more options 

New Page 
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Gallery tab 

You can search the gallery to find and use many graphics: images, pages, videos, Flash files. 

Gallery search 

There are two ways to find content. A. click in the Search box and 

enter a word, B. browse to a collection related to a general topic 

and browse through it. 

Gallery objects 

Objects are organized into three main areas: Pictures, Interactive 

and Multimedia, Notebooks Files and Pages. 
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My Content 

My Content is reserved for objects you have imported, captured or created. It is a good place to store 

objects that you will use in multiple presentations. To add an item to the My Content area, drag it from the 

work area to the My Content area. 

You can store an entire Notebook file in this area. Do this if you will give a presentation multiple times. To 

launch a file from this area, drag it to the main work area. 

 

Note: In most districts, Export the My Collections at the end of each school year so it is not erased when 

the computers are re-imaged. 

 

Attachments tab 

The Attachments tab allows you to link to supporting documents, to allow your presentation to have an 

easy flow. 

To insert a copy of a file, click the Insert button at the bottom of the attachments tab, select Insert Copy of 

File. 

 

 

Note: when you have placed an object in the Attachments tab, the appearance of the tab changes to 

remind you that something is in this area. 
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Properties tab 

The properties tab is a quick way to alter the appearance of an object.   

 

To select any object to change its properties, first click on the Select Tool.   

 

   

 

 

 

 

 

Sharing SMART Notebook files 

A. Select File > Save to send to someone with SMART 

Notebook software. 

B. Select File > Export and save it as a webpage for 

internet users who don’t have SMART Notebook 

software installed.  

C. In the District, save Notebook files to your N:Drive. 
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Using objects in SMART Notebook software 

Objects in SMART Notebook are digital pictures, clip art, typed text and handwritten notes. These things 

can be modified for size, rotation, color, and linking. 

 

 Rotate and resize 

o Select the object. Click and drag your mouse on the green circle at the top of the object. 

 

 

 Moving objects 

o Click and drag from the center of the object to move it to a new place on the page.  

o You can also drag an object from one page to another page in the Page Sorter tab. 

o You can also move objects using Cut and Paste or Copy and Paste.  

 

 

 Alignment Guides 

o Allow you to control the placement of object exactly where you want them to be.  

Click Format > Alignment. 

 

              Gray lines mark the center of the page: 
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 Locking objects 

o Locking an object allows you to protect the properties you’ve applied to an object. The 

object cannot be moved or altered in any way. 

 Grouping objects 

o Use grouping to save you time when moving many objects together. This preserves the 

layout and spacing of the set of objects. 

o Hold the Shift key down while selecting several objects, and then choose Group.  

 Infinite Cloner 

o When you choose Infinite Cloner, the infinity symbol appears in the 

top-right corner of the object. 

o Now each time you click to drag from the object, you will get a clone of 

that object. You can do this an unlimited number of times. 

 Flip objects 

o Useful when teaching transformations or graphing in math and science. 

o Useful when teaching letter recognition to younger students, ex. whether a capital E is 

turned correctly. 

 Order objects 

o You can change the order in which objects are layered. 

o Choices are: Bring Forward, Send Backward, Bring to Front, 

Send to Back. 

 

 

 

 

Add a link to an object 

Adding links is a way to access information from within your presentation quickly and efficiently, 

without having to pause the presentation  to browse for the file you want.  
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Handwriting recognition 

If you write something with a pen tool, you have the option of having that writing converted to typed text. 

The software compares your writing to the dictionary and comes up with suggestions of what it thinks is a 

close match. This is useful if you have added notes during a presentation and want to insert them into the 

presentation.  

  

 

1. Write a word on the board. 

2. Click on the drop down menu in the upper right hand corner and select the recognized 

word you want to use.  

Shape recognition 

Shapes can also be recognized as letters and numbers. If you draw a shape with a pen tool, you can go to 

the drop-down menu when the shape is selected and choose Recognize Shape to convert it to a shape. You 

can also use the Shape Pen from the SMART Notebook toolbar to draw instant shapes.  

To remove a shape, you must delete it. The erase tool doesn’t remove shapes.  

1. Click the Shape Recognition tool.   

2. Draw a shape. If the SMART Notebook recognizes your drawing, it adds this shape to the 

page. 
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Typed text 

1. Press on the Text object icon. 

 

2. Use the keyboard to type some text.  

3. The Fonts toolbar appears.  

4. You can edit the text and change the font style, size, bold, italics, underline, color, rotation, 

subscript, superscript. 

5. If you want to add a math symbol, click on the Mathematical Symbol icon in the Fonts 

toolbar. 

4. The toolbar expands to display 23 symbols. Each group of two or three symbols represents a 

symbol category.  

5. Click a category, and a drop-down list of symbols appears. 

6. Click the symbol you want to add to the text, and the symbol appears in the text object. 

 

Check spelling 

You can check spelling either while you are creating the text object or 

after the object has already been inserted on the page. 
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Drawing Tools 

You can use the drawing tools in the Notebook software toolbar to create your own objects.  

 

****Note: the software will recognize the last tool you selected until you choose the Select tool.  

Line tool 

 

Pen tool 

 

Eraser tool 

 

Shapes tool 

 

 

Fill tool 

  Any shape can be quickly filled with color by tipping the paint can over the shape object. The fill 

color is the last color chosen from the color palette. To change the color in the paint can, click the shape 

icon, click the paint can, click the Properties tab and select a color from the color palette.   
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Creating interactive lessons 

Lesson activities need to be designed for both content and presentation.  Once you have determined what 

content you will be teaching, create a title page and write your teacher’s notes at the beginning of your 

lesson activity. Title pages and teacher’s notes provide important information to other teachers who may 

use the lesson, and helps you remember how you created the lesson. 

To begin designing your page, choose a background color. Keep in mind that very bright or intense colors 

can be distracting and draw attention away from the content. Reserve the most vibrant colors for individual 

objects on the page to which you want to draw student attention. 

The following five pages give some ideas for making a page more interactive, instead of simply presenting 

the information all at once to students. Add more ideas in the space below: 
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Move and Reveal 

1. Type your question and answer.  

2. Draw a rectangle and fill it with color to hide the answer. 

3. Double-click the shape for the ability to add text to it – ensure your text is a different color from the 

rectangle. 

4. Type Move the box to reveal the answer – you are adding instructions to the shape so students, 

other teachers or a substitute would know what to do.  

5. Use Order>Bring to Front on the shape that covers the answer. 

6. Move the shape to reveal the answer. 

 

 

 

Erase and reveal 

1. Type your question and answer. Use a pen to cover the answer with digital ink. 

2. Click on a pen tool. Choose an ink color the same color as the page background.  

3. Click on the Eraser tool, and erase the digital ink covering the answer.  

4. Note: The eraser tool will only erase object created with digital ink. Anything typed with your 

keyboard cannot be erased with the Eraser tool.  Shapes, straight lines and imported graphics 

cannot be erased with the Eraser tool. 

 

 

 

 

 

  

Before:                                                            After:   

Before:                                                            After:   
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Order and reveal 

1. Create an object. 

2. Create a second, larger solid object. 

3. Move the larger object over the smaller object, which will be hidden.  

4. When it is time to reveal the smaller object, you can either move the larger object aside or change 

the order of the larger object to Send to Back. 

 

 

 

Screen Shade 

1. Type your question and answer. 

2. Click the Screen Shade button on the SMART Notebook software toolbar 

3. Drag the Screen Shade so only the answer to your question is covered 

4. When you are ready, drag the Screen Shade so it no longer covers the answer. This action is similar 

to using paper to cover answers that would be displayed through an overhead projector.  

5. Note: When you open a Notebook file, the Screen Shade will be exactly where it was left when you 

had the file open last. 
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Identify and Label – Drag and drop 

 

Drag the labels to the appropriate part of the diagram 

 

You may want to add a link to an object, such as the eyeball above, to another Notebook software page with 
an answer key. This page will help anyone you share the file with find the correct answers. 

 

 

 

 

 

Drag and drop activities can also be used for text-based lessons. For example, you might drag events to 
specific dates on a timeline or define a series of words. 
 
 

 
Drag the labels to the appropriate part of the diagram 

Match the words with their definition 
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Infinite Cloner 

1. Click an object. 

2. Click the object’s drop down menu and choose Infinite Cloner. 

3. Click and drag from the object to create a duplicate.   

 

 

 

Set each number on the number 
line as an Infinite Cloner.     Use the same number multiple 
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Magic Pen Spotlight 

The Magic Pen allows you to highlight parts of your page in a way similar to the Spotlight tool on the board. 

1. Draw a circle shape on the part of the work area you wish to highlight.  

2. When you move your cursor over the magic shape, it turns into a double-ended arrow. This 

arrow allows you to make the highlighted area larger or smaller.  

 
 

 

 

Magic Pen Zoom 

When you use the Magic Pen tool and draw a rectangle around an area on a page, you can zoom into that 

area.  

When your cursor approaches the magic shape, it turns into a hand, which allows you to zoom on a 

different area. 

 

 

Writing with Magic Pen Tool 

When you write with the Magic Pen the ink disappears in a few seconds.  
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When and why to use an interactive whiteboard 

 An interactive whiteboard can do anything a computer can do. 

 Integrate with other technology. You can use DVD players, document cameras and video cameras. 

 An interactive whiteboard can’t and shouldn’t replace every classroom activity. Some activities are 

better done the old fashioned way, for example, learning to print, real science experiments, live 

speakers, field trips, learning to paint, real musical instruments, and individual use of 

manipulatives. 

 

Instructional Design Notes 

 Convey content clearly. 

 Give your lessons a title page. 

 Consider your background color. 

 Select fonts that are easy to read. Use one font for most things. 

o Use fonts that are installed on your computer to avoid problems when opening lessons 

made at home or other places with special fonts. 

o Titles should be at least 28 pts and bold. 

o Text for sentences and paragraphs should be the same font as the header, 22 pts and 

regular (not bold). 

o Font color should be easy to read against the background. 

 Don’t be afraid to start a new page. 

 Don’t cram too much text on a page. 

 Develop consistent themes. 

 Make links obvious. 

 Use interactivity and multimedia judiciously. 

 Make a note in a teachers section at the beginning of prior knowledge and lesson objectives. 

 Consider literacy level of the class. 

 Differentiate instruction seamlessly. 

 Enable active student participation. 

 Create hide-and-reveal activities. 

 Create drag and drop activities. 

 Incorporate Flash activities. 

 Incorporate sound. 

 Invite students to the board. 

 Use wireless slates for students with disabilities. 

 

  



SMART Notebook 10.6 

  28  

Downloading the Notebook software at home 

1. Go to www.smarttech.com  

2. Locate the download page. Either click on Support/Downloads 

or    http://www.smarttech.com/us/Support/Browse+Support/Download+Software  

3. Locate the  

4. Choose either Windows or Mac operating system. 

   

5. Fill out the form and click on Start Download button. 

 

6. Wait for the confirmation notice to appear. Save the file to your computer. Wait for it to finish 

downloading (may take several minutes to a half-hour depending on your computer speed).  

http://www.smarttech.com/
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7. If a message appears, you can click on “run”,  

OR   find the downloaded file and double-click to open and install it on your computer. 

8. Scroll to near the bottom of the screen and click on the Download button. 

 

 

Code to unlock and use the software: 

NB-AEAA8-D2EW4-XWHQB-34ASC 
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What is Ink Aware? 

When a software application is considered Ink Aware, you can write and draw directly into the active file. 

For example, if you write a note or draw something while using Microsoft Word software, you can save 

your Word file and your notes will be visible the next time you open it. Other Ink Aware applications 

include: Excel, PowerPoint , Corel DRAW, Microsoft Imaging, Microsoft Paint, Adobe Acrobat. 

 

 

Ink Aware Applications – Word 

 

 

  



SMART Notebook 10.6 

  31  

Ink Aware Applications – Excel 

 

 

 

Ink Aware Applications – PowerPoint 
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Linking 

Linking can significantly improve the flow and organization of your lesson. You can link any object on a page 

to a webpage, an external file, an attached item, or another page in the same lesson. This lets you move 

between the pages easily without using the Page Sorter. You can create objects that serve as navigation 

buttons.  

1. Press the drop-down arrow of an object.  

2. Choose Link. 

3. Select Page in this File. 

4. Select the page you would like to link to. 

5. Click OK. 

 

 

 

 

 

 

Dual Page Display 

1. Press the Dual Page Display button on the toolbar OR select the View menu, then Zoom, then Dual 

Page Display.  

Pin Page 

1. Select View menu, then Zoom, then Pin Page. 

2. OR press the Pin Page button on the toolbar  .  If this icon is not showing on the toolbar, you 

will have to Customize the toolbar and drag this icon there. 

Page Grouping 

This is useful to keep your pages organized when you have a large number of pages. For example, you can 

create a group called “Introductory Pages”, or “Activities”, or “Conclusion”, etc. 

1. Press the Add New Group button. 

2. Press the group drop-down and choose Rename Group. 

3. Type a name for the new group.  

4. Drag and drop pages into the correct group. 
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Tables 

1. Press the Table button,  

OR  Choose Insert, then Table. An eight by eight grid appears.  

2. Select the number of columns and rows that you would like to include in the table by dragging over 

the cells in the grid. 

3. The table appears on your page. 

 

 Add object to table cells 

o Drag an object into a cell. 

 Add text to table cells 

o Double-click on a cell and start 

typing.  

 Select the whole table 

o Use the marquee selection method. 

Begin dragging outside one corner 

of the table and drag to make a 

selection around the entire table. 

 Select rows and columns 

o Press inside the table area and drag 

over the specific cells you would 

like to select. 

 Move the table 

o Select the whole table. Then use 

the handle in the upper left corner to drag it to a new location. 

 Resize the table 

o Select the whole table. Use the handle in the lower right to click and drag and resize the table. 

 Resize columns or rows 

o Place your mouse or finger on the line that divides the column or row. A double-headed arrow 

appears. Drag the line left/right to resize columns, and up/down to resize rows. 

 Insert or remove columns, rows, or cells 

o Select a column or Row, then: 

o Right-click and choose Insert Column or Insert Row 

o Right-click and choose Delete Column or Delete Row 

 Split cells 

o Select some cells. Right-click and choose Split into . . . .  

 Merge cells 

o Select some cells. Right-click and choose Merge  

 Add a Shade to a cell 

o Similar to Screen Shade, will cover the contents of an individual cell, row or column.  

o Select the cell(s), right-click and choose Add cell shade. 

o To remove, right-click and choose Remove cell shade. 

o To reveal, press once on the cell shade. 


